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1 Introduccion

El presente documento describe cuales son las tareas basicas que se pueden ejecutar en la explotacién
de la herramienta de modelado Enterprise Architect Corporate Edition.

El contenido del documento integra, tanto los aspectos de uso en el entorno de EJIE como las
caracteristicas elementales de funcionamiento de la aplicacion.

2 Conceptos basicos

Enterprise Architect Corporate Edition es una herramienta CASE para el disefio y construccion de
sistemas software. Desarrollada por Sparx Systems, la primera release (v1.1.3) data de Agosto del 2000,
mientras que la ultima versién (v6.1) vio la luz en Mayo del 2006

Enterprise Architect Corporate Edition soporta la especificacion UML 2.0, que describe un lenguaje visual
que permite la definicién de los modelos de un proyecto.

Se trata de una herramienta progresiva que cubre todos los aspectos del ciclo de un desarrollo,
proporcionando una completa trazabilidad desde la fase inicial de disefio hasta el desarrollo y posterior
mantenimiento. Asi mismo, también proporciona soporte para testing y control de cambios.

Enterprise Architect Corporate Edition, permite la realizacion de ingeniera directa e inversa, sincronizar
los elementos de los modelos con el cédigo fuente de las clases (ActionScript, C++, C#, Delphi, Java, Python,
PHP, VB.NET y Visual Basic), disefiar y generar elementos de base de datos y generar documentacion de gran
calidad facilmente exportable a formato RTF.

Enterprise Architect Corporate Edition soporta todos los modelos/diagramas de UML 2.0. Permite disefiar
desde procesos de negocio, sitios web, interfaces de usuario, configuraciones hardware, hasta estimar el
esfuerzo del proyecto en horas

Aunque el producto contempla dos tipos de repositorio (ficheros EAP o Base de datos) se ha optado por
el que mas posibilidades aporta, es decir, el basado en Base de Datos

Function EAP DBMS
Replication Yes NO
Number users 1..10 10..*
Non-Corruptible No Yes

El repositorio basado en DBMS proporciona mejores tiempos de respuesta cuando se trabajo con varios
usuarios debido a su estructura interna. Ademas, cualquier problema de conexidén que se produzca, deberia ser
cubierto por las habilidades del servidor DBMS, permitiendo deshacer cualquier transaccién interrumpida por
problemas externos.

En nuestro caso se ha seleccionado SQL Server 7.0 como repositorio de proyectos, y la licencia
Corporate Edition.
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Enterprise Architect Corporate Edition implementa la tecnologia MDG (Model Driven Generator) que
permite centralizar una coleccién de recursos pertenecientes a una tecnologia especifica en un punto concreto
de Enterprise Architect Corporate Edition. Con MDG, el usuario tiene la posibilidad de realizar una importacion
granular de perfiles UML, patrones UML y plantillas en una Unica y accesible area contenida en la “Resource
View” de EA.

Para obtener informacién adicional sobre el producto acceder a su pagina web:

http://www.sparxsystems.com.au/products/ea.html

3 Funciones elementales

Aunque la herramienta permite gestionar dos tipos de repositorios (fichero EAP o Base de datos) se
recomienda el uso de la opcidn de base de datos, ya que permite el trabajo concurrente a mayor numero de
usuarios, evita la degradacién del proyecto y mejora los tiempos de respuesta del producto. No obstante el
responsable del proyecto podra seleccionar la opcién mas conveniente en cada caso.

Nota: El presente manual esta orientado principalmente al uso de DBMS como repositorio de modelos del
proyecto

Los pasos minimos que debe ejecutar el responsable del proyecto se pueden resumir como:

Solicitar el repositorio del proyecto en BD

Crear el proyecto

Activar seguridad

Establecer usuario(s) administrador(es)

Crear grupos de usuarios y asignarles privilegios
Crear usuarios y asignarlos a grupos

3.1 Crear el proyecto

Previamente (en fase 0) se habra solicitado al servicio de implantacion la creacién del repositorio en
SQLServer, facilitandonos los siguientes datos:

= Nombre del servidor

= Nombre de la base de datos
= Usuario

= Password

Importante: El proceso descrito a continuacién lo debera ejecutar el responsable del proyecto una sola
vez. Las sucesivas veces que se llevase a cabo supondria perder todos los modelos contenidos en el repositorio
remoto, es decir, seria equivalente a un proceso de reinicio del proyecto.

Que implantacién nos confirme la creacién del repositorio no significa que ya podemos empezar a

trabajar, tan solo disponemos del espacio necesario para gestionar el proyecto. Por tanto el primer paso a
realizar por el responsable es crear el proyecto, ejecutando el menu Tools-> Data Management->Data Transfer
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Full Model Data Transfer, E|

[rata Transfer Tupe
() EAPto EAP (O DEMSto EAP () EAPtoDEMS () DEMS to DEMS

Source and T arget kM odels

Source Model; | L | [ ]
Target bModel: | | | |

Loofile

ClLogile | |

Caution: All data will be erased fram the T arget bModel priar to data ransfer. Please ensure you
have backed up target if neceszan

IransferData] [ Cloze ] [ Help J

Frogress:

Completamos la pantalla:

= En el tipo de transferencia a realizar marcamos la opcién “.EAP to DBMS”

= En el campo de “Source Model” pinchamos el botén “...” que aparece alineado permitiéndonos
asi buscar en nuestro disco un fichero EAP que vamos a usar como modelo, bien porque lo
tenemos de otro proyecto similar anterior o bien si no disponemos de ninguno, podemos
seleccionar “ el que se instala por defecto con la herramienta EABase.eap”

= Pinchando el botoén “...” alineado con “Target Model” seleccionaremos como destino la BD SQL
Server que nos han generado:
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B2 Data Link Properties

Provider Eu:unneu:ti-:unl .-ﬁ-.dvancedl &l I

Select the data vou want b0 connect bo;

EJie

OLE DB Provider(z]

MediaCatalogDB OLE DB Provider
tediaCataloghergedDB OLE DB Provider
tediaCatalogiw/ebDE OLE DB Provider
Micrazoft Jet 4.0 OLE DB Provider

icrozoft OLE DE Provider For Data kining Services
ticrozoft OLE DE Provider for DTS Packages
bicrozaoft OLE DB Provider for Indexing Service
ticrozoft OLE DB Provider for Intermet Publishing
Microsoft OLE DB Provider for Microzoft Search
Micrazoft OLE DB Prowider for ODBC Drivers
Micrazaoft OLE DB Pravider for Olap Services 2.0
Microzoft OLE DB Provwider for Oracle
icrozoft OLE DB Provider for SOL Sepver
Microzoft OLE DB Simple Provider

k5D ataShape

F'rIDveeu:Icur de bazes de datoz OLE para zervicioz de dire
1

Mest »»

clor ™
3

Aceptar | Cancelar |

Ayuda |

O

Una vez se ha seleccionado el driver de conexién a la base de datos (Microsoft OLE DB

Eusko Jaurlaritzaren Informatika Elkartea
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Provider for SQL Server) se debera indicar la conexidn a la base de datos:
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B2 Data Link Properties x|

Prowider Connection |.-'1‘-.|:|van|:eu:|| All I

Specify the following to connect to SEL Server data:
1. Select or enter a server name:

|SEFWEF| v| Befresh |

2. Enter information to log an ta the server;
" Use Windows NT Integrated security

¥ Usze a specific uzer name and pazaword;

Ilzer name: Is.'-"3a_ea

EETERTT

Pazsword: I
[~ Blank password [ Allow saving password
3, (% Select the databaze on the server:
|5738_E4) =
" Attach a database file as a databaze name:;

IJzing the filename;

| N

Test Connechion |

Aceptar I Cancelar Ayuda |

Una vez de vuelta a la pantalla de transferencia de datos pinchamos en “Transfer Data” iniciando asi el
proceso de carga, aunque nos avisara de que todos los datos que contenga se perderan.

EA Eq

"j “Warning: ALL DATA in the target model will be deleted prior to uploading new data, Press OF to continue, CANCEL to
. abark

[ Aceptar |[ Cancelar

Terminado el proceso pinchamos en “Close”.

Con esto ya tenemos realmente creado el proyecto.

3.2 Conexién al repositorio/proyecto

Una vez creado el proyecto nos conectaremos al servidor para ajustar la configuracion de seguridad y el
trabajo en grupo.
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Lo comentado a continuacion sirve como guia de conexién al repositorio remoto para cualquier tipo de
usuario.

ENTERPRISE O -
ARCHITECT v40 Seatch L]
Wy Profile..
Set Local Options...
Help with Enterprise Architect...
Manage Projects Recent Projects

* Open a Project File_..
* Create a Mew Project. ..
» Connect to Server__.

Pinchando sobre “Connect to Server...” se muestra la pantalla de seleccién de driver de conexion a BD
seleccionando Microsoft OLE DB Provider for SQL Server. Después indicaremos los parametros de conexion a
la base de datos. Ahora hay que darle como nombre el cédigo de aplicacion:

Connection Mame & Type

M arne:
is?Sa i

D atabaze Server

kS SOL Server...

(] 4 l [ LCancel

Si la configuracién se ha efectuado de modo correcto, se cargara el proyecto EAP residente y existente
en la base de datos a la que se ha realizado la conexidn, pudiéndose observar en la vista “Project View” los
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diferentes paquetes que componen el proyecto :

Praoject Wiew

B~ B- i 4 R

Clases Implicadas

lﬁlpruject Wigw l@Resnurce Wigw

En la pantalla principal se ofrece la posibilidad de abrir un proyecto ya existente, crear un nuevo proyecto
y/o conectarse a un servidor. Al haber seleccionado como repositorio de documentacion la opcion de base de
datos, el primer paso que debera realizar cualquier usuario (ademas del responsable de aplicacion) al iniciar la
aplicaciéon sera conectarse al repositorio a través de la opcién “Connect to Server”.

Si se ha activado la seguridad del proyecto y al usuario que intenta acceder se le ha dado de alta sin la
posibilidad de utilizar la seguridad Windows (no recomendado), le aparecera la pantalla de autenticacion:

& Login to EA Repository E|

| zer D

Pazzword:

|.:|. R emember zerlD

[ Login l [ Cancel

Este punto se explicara mas adelante.
3.3 Modelo de seguridad

Enterprise Architect Corporate Edition permite aplicar seguridad de acceso al proyecto, ademas de
habilitar el acceso Unico a cada modelo con objeto de impedir modificaciones paralelas no deseadas.

Aunque en cualquier proyecto, y por defecto en su creacion, el modelo de seguridad que es aplicable a
partir del propio Enterprise Architect, esta deshabilitado, se recomienda mantenerlo activado. Asi, el responsable
de proyecto una vez generado (ver el apartado “Crear proyecto” del presente manual) debera ejecutar los pasos
indicados a continuacion.
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Importante: El proceso descrito a continuacién solo lo debera ejecutar el responsable del proyecto.

Para poder activar la seguridad se debera tener activo el propio proyecto. Si éste no dispone de politica
de seguridades aplicada, la activaremos accediendo al Project > Security=> Enable Security.

& PetStore - EA - Corporate Edition o =1
: Fle Edt iew | Project | Diagram Element Tools Add-Ins  Add-Ins  Settings  ‘Window Help
: D)0 | | a0 koo cohew s s OB ABIE . e - oo -5 B
Tool - & X 5t A} Diagram. . Chrly »  Project View -3 x
Al =] ——] T8l Add Element Chrl+M B F- | eren | Byl d
Analysws| = @ Documentation g Sieeliel E B @ Vistas
Requerimientos Generales

£ Actor Source Code Engineering 3 [®] Casos de Usa

1 Object Build and Run 4 Casos de Test

> Process Database Engineering 3 Diagrama Clases .

G Diagramas Secuencia

7 Callab, Architect...

O Send Madel Transformations ] Diagrama de Estada

o Clases Implicadas

=] Recsive il Modgl Validation i Recent Projects

L € | - Weh Services »

| = #ML Schema 3 aihf

Class Sl

Composite Security 3 :

Maintain Users...
Communic. .. Version Contral 3
= Mainkain Groups...
Import/Export 3
Interacon partiEsp Wiew and Manage Locks. ..
Timing Manage Baselines. .. Chri+alt+5 IﬁEEIProject igw l@Resource View
5 Change Password. .. -
State . Use Case Metrics... e Inskant Help nx
o ogin as Another User.,,
Ackivity Wl Views Project Statistics. ., N i — i @ IE @ | a
Manage My Lacks.,,, thH-Mayusculas+
Campanent IIJ Conceptsks
7 &# Basic Tasl
Deployment |'Qa Enable Security. . GQuick Guide to EA
e Reguire ser Lock to Edit UML Madels
! Encrypl Password, ., Typical Roles
Rlail Code Engineering
Metamodel Database Modeling
Documentation
AL Sich
SLEmR Project Management

WSDL MDG Technology

Requireme. . &% Model Management:

Maintenance

User Inter...

EPMM Core

EPMM Types || q Start Page ] I G Mates I%Properties l@lnstant Help

;%vév;V|1 :§f|DeFault5tyle

- p-RkdEsanend eaaaaalzay xi

Enable security in model

Se solicita un cédigo de autorizacion que debemos completar.

Enter authorization

Enter autharization key:

Ok l [ Cancel ] [

Help

Nota: Esta clave se facilita cuando se hace la compra del producto.

CAP NUM SCRL

Una vez introducida nos avisa de que ademas se ha generado un usuario administrador por defecto:
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EA E3

Security has been enabled an the current model, Yau can now login as ‘'admin’ with the passwaord ‘passward' and
] create and administer users, groups and permissions'

Acepkar

Una vez activada la seguridad se recomienda marcar la opcién “Require User Lock to Edit”, lo que
garantizara que no habra modificaciones indeseables por modificaciones concurrentes de mas de un usuario al
mismo objeto. Con esta opcidn el usuario antes de poder realizar cualquier modificacion debera bloquear el
objeto, asegurando entonces su uso exclusivo. Asi, una vez finalizado el cambio debera desbloquearlo.

Enterprise Architect pide confirmacion antes de efectuar esta operacion.

Ea x|
& You are about o change the locking mode so that elements can OMLY BE EDITED iF wou LOCE therm,

This represents a complete inversion of the current behavior, and wou should only proceed iF you are certain of the
CONSEqUENCEes,

Do wou wish to proceed?

Enterprise Architect también admite otros modelos de bloqueo menos restrictivos, por lo que sera
decision del responsable de aplicacidén adoptar la mejor opcion para cada caso.

Una vez se ha accedido al proyecto con las credenciales autorizadas se podran realizar sobre el proyecto
seleccionado las operaciones asociadas a los diferentes perfiles que se hayan creado para el proyecto, y en
funcion del usuario autenticado podra efectuar aquellas operaciones que le estén permitidas.

Una vez ha sido habilitada la seguridad, se puede acceder a las otras opciones de administracion.
3.4 Trabajo en grupo

El repositorio basado en DBMS proporciona mejores tiempos de respuesta cuando se trabajo con varios
usuarios debido a su estructura interna. Ademas, cualquier problema de conexién que se produzca, deberia ser
cubierto por las habilidades del servidor DBMS, permitiendo deshacer cualquier transaccion interrumpida por
problemas externos.

Los repositorios DBMS no ofrecen los servicios de replicacion que ofrecen los repositorios EAP. Esta
funcionalidad es cubierta por el Control de Paquetes y el Control de Versiones.

Cuando se utiliza DBMS como repositorio, la exportaciéon/importacion XMl se puede utilizar para modelar
distintos paquetes, exportar a XML y compartirlos entre los miembros del equipo de desarrollo, o incluso como
escenario de intercambio con las empresas colaboradoras. La utilizacién de DMBS tiene amplias ventajas con
respecto a la replicacion:
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1. Se puede crear un modelo con solo las partes necesarias para la realizacién de un determinado
trabajo

Se puede crear el modelo completo en caso de ser necesario

3. Se puede crear un modelo desde diferentes versiones de paquetes con distintos propésitos (vista
cliente, version definitiva interna)

Menor probabilidad de colisiones entre desarrolladores si cada uno trabaja en distintos paquetes.

El proceso es controlable utilizando el sistema de control de versiones

El responsable de la aplicacién sera el encargado de realizar los mantenimiento de usuarios y grupos
para el proyecto

3.4.1. Mantenimiento de usuarios

Importante: El proceso descrito a continuacion solo lo debera ejecutar el responsable del proyecto.

Para gestionar los usuarios y la asignacion de estos a los posibles grupos y permisos identificados para el
proyecto acceder al menu Project-> Security->Maintain Users:

System Users i X
— Uszer Detailz — Set Permiszions
Logir: ||
Elapir I Eroup fembership |
SUINEME: I Single Permizsions |
Department; I
viewsll |

Change Pazsward |

[T Acceptwindows Authentication

Izers:; Mews | Save I Lielete |

Surmame | Firsthame | Login |
Adrinigtrator The adrnin
petstore petstare petstore

Help | Cloze |

Para efectuar un alta de un usuario en el sistema, se pulsara el botén de “New”, el cual permite acceder al
apartado de User Details con todos los campos en blanco para proceder a su definicion:
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— Uzer Detailz

Logir: I
Firstname: I
Surnarne: I
Department; I

EChange Pazzword |

[ Accept Windows Suthentication

Se recomienda utilizar el sistema de credenciales compatible con las propias de acceso al sistema
Windows, para ello bastara tan solo el activar la casilla “Accept Windows Authentication”. Una vez introducida la
informacion, procederemos a almacenar la misma pulsando el botén”Save” apareciendo entonces en la lista
“Users”.

Para efectuar una actualizacion de los datos asociados a un usuario en el sistema, se procedera a
seleccionar previamente al usuario de la lista, se cumplimentara la informacion del usuario a modificar existente
en el apartado de “User Details” con todos los campos con la informacién original ya cumplimentada y pulsar
“Save”.

Para efectuar un borrado de un usuario del sistema, se procedera a seleccionar previamente al usuario
de la lista, se pulsara sobre el boton “Delete”, el cual procedera a realizar el borrado del sistema. Es muy
resaltar que el borrado es fisico y que el sistema no pide confirmacion del mismo, por lo que se debera estar
muy seguro de la operacion a efectuar, ya que la misma no es reversible.

Si lo que se desea es asignar o quitar privilegios al usuario, se procedera a seleccionar previamente al

usuario de la lista, y en funcion a los privilegios que se deseen asignar o quitar al usuario, se seleccionara una
de las tres opciones posibles:

— Set Permizzions

Group Membership |

Single Permigzions |

Viewsl |

La opcion “Group Membership”, permite la asignacién/desasignacion de un usuario a un grupo. Una vez
pulsada esta opcidn, mediante botones de opcion, los que estén marcados generaran la pertenencia a los
grupos marcados y los que no estén marcados el usuario no dispondra de pertenencia a ellos:
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A

il SES

: s ecEncia
— Uzer Details — Set Permizgzione———— i

Firstnarme: IDEtSlUfE Brel s nlaibe s Tick Required Groups:

Sl Ipetst-:-re Single Permizzions | [ Jésdrninistrators
Department; IDEtSlDfE
Wi Al |

Change Pazsword |

[ Accept wWindows duthentication

- System Users

Users: Mew | Save | Delete
Surname | Firzthame | Login |
Adrminiztrator The admin

petztore petztore petstore

] I Cancel Help

Help | Cloze |

La opcidn “Single Permissions”, permite la asignacidon/desasignacion de un usuario a los diferentes
permisos existentes en el sistema. Una vez pulsada esta opcidon, mediante botones de opcion, los que estén
marcados generaran la pertenencia a los permisos y los que no estén marcados el usuario no dispondra de
pertenencia a ellos. Se recomienda asignar permisos a través de la pertenencia a un grupo al cual se le asignen
los permisos deseados:

[ ] Al U s
: Ciagrama Clases

Diagramas Secuencia
Diagrama de Estada

Lagin: petstare i
: ',7 L CIETTE— x
Eirstrae petstore Group tembership

Tick required permizzions

; I etstare ; o
A : Ml [ 1&dminister Databaze - ak. I
Department: Ipetstore - [w|Change Password
Change Passward View Al | DEhec.:k Drata Inkegrity Cancel |
| [ 1Configure D atatypes
["Configure Images Help |

System Users

r— User Detail — Set Permissions

¥ Accept Windows Authentication [w]Configure Packages
["]Configure Resources
Users: Hew | Save | Delete | [Configure Steraotypes
[ ]Configure Wersion Control
Surname | Firstname | Laogin | WE spatt 5]
Adminigtrator The adrnin [|Generate Documents
petstare petstore petstore WiGenerate Source Code and DDL

M Im |
[ ILock Elements LI

&% Code Enginesring

$ Database Modeling
¢ Documentation

&P Project Management

Help | Cloze |

La Opcioén de “View All” es una combinacion de las dos anteriores, por lo que se veran todas las opciones
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EJie

juntas y mezcladas en la misma pantalla de asignacion, desasignacion.

— Uger Details
Laogin: petstore
Firstname: petstore
Surname: Ipetstore

Department; IPBtSlDfB
Change Pazzword |

— Set Permissions

Group Membership |
Single Permizzions |
Wiew &l |

¥ accept Windows Authentication

Help |

Users: Mew | Save | Delete |
Surmame | Firstname | Laogin |
Adrmiristrator The adrmit

petstore petstare petstare

Close |

Ll ] e e @

Ciagrama Clases
+ Diagramas Secuencia
[+ [#] Diagrama de Estado

All user permissions E *|

Aszzighed permissions:

[ 1Administer Databasze -
[1Change Password

[C]Check Data Integrity

[1Configure Datatypes

["1Configure Images

[1Configure Packages

[1Configurs Resources

[1Configure Stereotypes

[ 1Configure Yersion Control

[C1E spart 3=kI

[ 1Generate Documents

[T1Generate Source Code and DDL

[lmport =l

[Lock Elements LI

3.4.2. Usuario administrador

Importante: El proceso descrito a continuacion solo lo debera ejecutar el responsable del proyecto.

g
&% Cods Engineering
Database Modeling

% Documentation

&% Project Management

Para evitar accesos no permitidos con perfil de administrador es basico actualizar los datos del usuario

administrador creado por defecto.

Acceder al menu Project—-> Security—>Maintain Users, y seleccionar de la lista “Users:” el referenciado
como “Administrador”. Poner como login el codigo de usuario utilizado para entrar al dominio Windows de
EJGVNET y marcar “Accept Windows Authentication”, con lo que no pedira usuario/password si ya estamos

autenticados en el dominio.

Es recomendable generar otro usuario con permisos de Administrador (perteneciente al grupo

“Administrators”).

3.4.3. Mantenimiento de grupos

Importante: El proceso descrito a continuacién solo lo debera ejecutar el responsable del proyecto.

Para gestionar los grupos y los permisos o privilegios identificados para el proyecto acceder al menu

Project-> Security=>Maintain Groups:
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Security Groups x|
Group Mame I
Dezcnption I
Set Group Fermizsions |
Groups: 2ave | Delete |
[aroup Mame | D ezcription |
Adriniztrators Syztemn Adminiztrators
Cloze Help

EJie
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Para efectuar un alta de un grupo en el sistema, se procedera a pulsar el botén de “New”, el cual permite
el acceder a la parte superior de la pantalla, con los campos de Nombre de Grupo y Descripcion de Grupo en

blanco para proceder a su rellenado:

Security Groups i x|
Group Mame I
Description I
Set roup Permizsions |
Groups: 2ave | Delete |

Una vez introducida la informacién, se procedera a almacenar la misma pulsando el botén “Save”, el cual
se habilita en el momento de haber cumplimentado toda la informacion asociada al grupo.
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EJie

Security Groups x|
Group Mame IpetstnreErDup
Description IpetstureErDup
Set Group Fermizsions |

Gioups: Mew | Save | Delete |

[aroup Mame | D ezcription |

Adriniztrators Syztemn Adminiztrators

Cloze Help

Para efectuar una actualizacion de los datos de un grupo en el sistema, se procedera a seleccionar
previamente al grupo de la lista, se cumplimentara la informacion asociada al grupo con todos los campos con la

informacion original ya cumplimentada.

1
i Security Groups

Group Mame IpetstnreGrnup

+ Deszcription IpetstnreGrnup description

1 Set Growp Pemmizsions |

Una vez introducida la informacién, procederemos a almacenar la misma pulsando el botén de “Save”, el
cual se habilita en el momento de haber cumplimentado toda la informacién asociada al grupo.

Para efectuar un borrado de un grupo del sistema, procederemos a seleccionar previamente al grupo de
la lista, se pulsara sobre el botén “Delete”, el cual procedera a realizar el borrado del grupo del sistema y elimina
automaticamente las asignaciones de usuarios pertenecientes a ese grupo. Es muy importante sefialar que el
borrado es fisico y que el sistema no pide confirmacién del mismo, por lo que se debera estar muy seguro de la

operacion a efectuar, ya que la misma no es reversible.
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Security Groups 5I

Group Mame IpetstnreErDup

Drescription IpetstureErDup D'escription

Set Group Permizsions |

Groups: New | Save I Delete |

[aroup Mame | D ezcription |

Adriniztrators Syztemn Adminiztrators
etstorelaron etztorelaroup

Cloze Help

Si lo que se desea es asignar o quitar privilegios al grupo, se procedera a seleccionar previamente al
grupo de la lista, y en funcion a los privilegios que se deseen asignar o quitar al usuario, se seleccionaran o no
los privilegios a asignar al grupo marcando o desmarcando las casillas de opcion habilitadas para tal fin:

Security Groups Group Permissions x|
Group Mame IpEtStDreGmup Tick required permissions
e e Administer D atabaze -
Description []
p IpetstoreGmup Dezcription FiCHarcsPassord
Set Group Permizzsions | [|Check Data Integrity
[ |Configure D atatypes

[ |Configure Images
Mew | e | Delete | [ |Canfigure Packages

Giroups: [ |Configure Resources
Group Mame | Dezcription | [ Configure Sterectypes
Administrators System Administratars | Configure Yersion Contral
petstoreGroup petztoreGroup Dezcription [ |E port 2|

[|Generate Documents
[|Generate Source Code and DDL

[ lmport =k
1 ael Flarmants LI

Cancel Help |

Cloze Help

Pare el conjunto de usuarios que van a colaborar en la creacion de los modelos se recomienda crear un
grupo con los siguientes permisos:
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Permission Meaning

Change Password Change password of current user.

Configure Datatypes Add/Modify and Delete Datatypes.

Configure Images Configure alternate element images.

Configure Packages Configure controlled packages and package properties.

Configure Resources Import and manage resources tab items: patterns, profiles, favorites etc.

Configure Stereotypes Add/Modify and Delete Stereotypes.

Generate Documents Generate RTF and HTML documents from model packages.

Generate Source Code and DDL Generate source code and DDL from model element. Synchronize if already
exists.

Lock Objects Lock an element.

Manage Diagrams Create new diagrams, copy existing and delete diagrams. Also save diagram as
UML Pattern.

Manage Issues Update and delete Issues.

Manage Project Information Update and manage resources, metrics, risks etc.

Manage Reference Data - Update Update and delete reference items.

Manage Tests Update and delete Test records.

Reverse Engineer from DDL and Source Reverse engineer from source code or ODBC. Synchronize with model

Code elements.

Security - Manage Locks View and delete element locks.

Spell Check Spell check package and set spell check language.

Update Diagrams Update diagram properties and layout, including the Page Setup dialog.

Update Elements Save changes (including delete) for elements, diagrams, packages, links, etc.

View Locks View element locks.

3.4.4. Gestion de bloqueos

Si se ha activado la opcion “Require User Lock to Edit” (recomendado) cuando un usuario bloquea un
objeto, debera liberarlo explicitamente cuando finalice su tarea de modificacion. Esto evidentemente puede
generar problemas, bien por olvido, bien porque sea necesario adquirir el objeto en un momento dado y el
usuario que lo tiene bloqueado no esta disponible, etc.

Es importante recordar que para poder bloquear un elemento el usuario debe tener perfil de administrador
o tener asignado el privilegio “Lock Objects “.

Para consultar y gestionar los diferentes bloqueos activos para el proyecto acceder al menu
Project-> Security>View and Manage Locks:
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EJie

X
Yiew Locks Far:
|V LA | i Groups Only ™ Uszers Only
At Select All I Select Hone
Type I ame IJzer | Group | Timestamp &
Diagram Cazozde ... admin Administrat...  19/07 /2006
Diagram Requermi..  admin 19/07 2006

Diagram Requenmi...
Diagram Requerimi...
Diagram SD-Bean ...
Diagram

adrmin

admit
adrmin

Adrinistrat...

190742008
19,07 /2008
19/07 /2006

19407 /2006

Diagram 1940742008 —
Diagram ACU_Pet5...  admin Administrat...  19/07 /2006
Element tilizacion ... admin 19/07 42006
Element Geston Ex..  admin 1940742006
Element Requerimi...  admin 1940742006
Comprar &...  admin 19407 /2006
Element Elirinar An...  admin 1940742006
Element Agregar .. admin 1940742006
Element Congultar ... admin 1940742006
Element Modificar ... admin 19072006
Element Consultar ... admin 19/07 420068 -
4| [»
nlock Selected Cloze | Help |
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Es importante recordar que esta opcion solo estara activa para usuarios administradores y para aquellos
a los que se les asigné el privilegio “Security - Manage Locks”.

Para desbloquear objetos, se puede seleccionar uno por uno de la lista, o pulsando “Select All” se

marcaran todos, pinchando después “Unlock Selected” se desbloqueran todos los seleccionados

Si ha activado la seguridad y la opcion “Require User Lock to Edit”, para bloquear un elemento, hay que

posicionarse en la pestafia “Project View” sobre el objeto que se quiere editar, y pulsando botén derecho

ejecutar la opcion “Apply/Release User Lock...”

Set User Lock

Achiar

..................................

() Releasze Uszer Lock

Include Child Packages

Esta opcidon de menu también permite el desbloqueo si nos posicionamos sobre algun objeto bloqueado
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previamente.

3.4.5. Otras funciones

Cambio de password

Opcién que permite la gestion de la contrasefia del usuario activo. Desde este apartado se permite
cambiar la contrasefa para el usuario que esta identificado en el proyecto en ese preciso instante. Para
ejecutarlo se debe acceder al menu Project-> Security=>Change Password

Change Password i x|

Enter old pazzword: || ] I
Mew pazsward: I Cancel |

Fietype new: I

Login como otro usuario

Desde este apartado se permite cambiar el usuario identificado o autenticado en el proyecto. Para
ejecutarlo se debe acceder al menu Project-> Security>Login As Another User.

@) Login to EA Repository x|
| gerl D Ial:lmin
Pazzwornd: ||

¥ Femember UselD

| Lagin I Cancel

Se permite un maximo de tres reintentos en la introduccién de un usuario y contrasefa validos para
acceder al proyecto. Si por un casual se intentara por mas de tres ocasiones consecutivas y estas fuesen
incorrectas o erréneas, el Enterprise Architect mostrara un mensaje de error, y realizara una salida del acceso al
proyecto seleccionado.

4 Integracion con la tecnologia MDG

4.1 Trabajando con tecnologias MDG

Las tecnologias MDG se aplican por cada proyecto, no son configuraciones generales de la herramienta
Enterprise Architect.

Para obtener informacion adicional, acceder a la pagina:
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http://www.sparxsystems.com.au/resources/mdg _tech/

4.1.1. Importar tecnologia MDG como fichero XML

En la ventana de “vista de recursos” del proyecto, y estando situados encima de la carpeta “MDG
Technologies”, con el botdn derecho seleccionar “Import Technology”.

Import Tedﬁnnlngr

Help

(B UME
UML Patterns
Code Management

Import Technology [z|

Technology: |Enterprise Java Beans | Yersion: 1.0 Beta

Filenarme: |E:"-.f1'-.r|:hiw:|s de programatSpars Systernstb DG Link\EJB\EJB | | |

Import Resources

Patterns Images T agged Valuez
Frofiles Code Modules
Profile Features Code Module Features
Element Size [rata Types
Alternate Image Code Templates

Color and &ppearance Code Options

Wi H Irpart H Cancel ] [ Help

Y pulsar “Import”

41.2. Uso de la tecnologia MDG

El posible uso de la tecnologia MDG importada en el proyecto dependera de las posibilidades a las que
esta destinado, y podran aplicarse a perfiles de elementos, patrones, plantillas de cédigo, modelos de datos, etc.
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i ﬁ Resources
=L ﬁ MDG Technologies
EI ﬁ Enterprise Java Beans

= (5] UML Profiles
= 3 UML Profile for E8
----- ¢ EJBCreateMethod
----- ¢ EJBFinderMethod
----- ¢ EJBRemoteMethod
----- =0 EIBEntityHomeInterface
----- =0 EJBRemotelnterface
----- =0 EIBSezsionHomelnterface
e EJBPrimarykey
----- ¢p EJBCmpField
----- ¢ EJBPrimaryKeyField
- - EJBRealizeHome
- o EJBRealizeRemote
----- EJBImplementation
----- [ EIBSessionBean
----- [C) EIBEntityBean
----- [0 ExB-18R
----- €] EJEDescriptor
-+ EJBClient]AR
----- —+ EJBAccess
------ —+ EJBReference
[ [28] UML Patterns
- |E] Code Management
- [ UML Profiles
o (2] UML Patterns
(L] Templates
Documents
- B2, Matrix Profiles
- Favarites
e Stylesheets

EPrDject View | @F‘.esource View

4.2 MDG Business Process

BPMN define diagramas de procesos de negocio, basados en la construcciéon de modelos graficos de
operaciones de procesos de negocio mediante la creacion de organigramas. Esta notacion es facilmente
entendible por todos los usuarios, desde los analistas que crean los primeros disefios de los procesos, hasta los
programadores responsables de la codificacion de dichos procesos, y finalmente, por los encargados de
gestionar y monitorizar dichos procesos.
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Woking Group
Still Active?

Chedk Status of
Warking Group

Send Current ssue List

Wiarking
Group
Auctive

Friday atGpm
Pacific Time

BPMN MDG proporciona soporte BMPN a Enterprise Architect

Proporciona a Enterprise Architect un completo entorno de implementacién de procesos de negocio.
Permite expresar dichos procesos a través de una notacion grafica estandar.

Compartir modelos

Los modelos de negocio y de software pueden ser combinados con BPMN, creando una unica aplicacion
para todos los modelos. Esto mejora la comunicacion y la productividad a lo largo del disefo.

Validacion de los modelos BPMN

Los diagramas de procesos de negocio pueden ser validados a través de una serie de reglas y
restricciones.

Frepare and Send
@ Candidate ltinaries

Travel Order E

Receive Confirmation

Send Cancellation
Maotice

Nota: Este producto tiene un coste adicional en su version basica, no teniendo coste adicional en

producto licenciado como empresarial o corporativo. Requiere un proceso de instalacion adicional y posterior a
la propia instalacion de la herramienta Enterprise Architect.

4.3 MDG for Eclipse

Proporciona una serie de caracteristicas a Eclipse que permite aumentar la productividad.

Con el link MDG para Eclipse, la navegacion entre Enterprise Architect y Eclipse es directa, mediante una

simple combinacion de teclas, se puede acceder directamente desde un modelo de Enterprise Architect a la
localizacion especifica del codigo en Eclipse.

Este link proporciona una interfaz flexible para el control de la importacién y exportacion de cddigo,
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ingenieria directa e inversa de todo un proyecto puede ser realiza en un solo proceso. El usuario tiene la opcion
de seleccionar que clases son incluidas en la importacién y exportacién, asi como la localizacion de los ficheros
de dichas clases. Incluso se puede compilar y ejecutar un proyecto desde Enterprise Architect.

Nota: Este producto tiene un coste adicional, por lo que actualmente no se ha considerado su compra.
4.4 MDG for Eclipse

El link MDG para Visual Studio .NET proporciona una solucién para los usuarios de la versiones
profesional y corporativa de Enterprise Architect y Visual Studio .NET. Proporciona una serie de caracteristicas a
Eclipse que permite aumentar la productividad.

Con el link MDG para Visual Studio .NET, la navegacion entre EA y Visual Studio .NET es directa,
mediante una simple combinacion de teclas, se puede acceder directamente desde un modelo de Enterprise
Architect a la localizacion especifica del codigo en Visual Studio .NET.

Este link proporciona una interfaz flexible para el control de la importacion y exportaciéon de cédigo,
ingenieria directa e inversa de todo un proyecto puede ser realiza en un solo proceso. El usuario tiene la opcién
de seleccionar que clases son incluidas en la importacion y exportacion, asi como la localizacion de los ficheros
de dichas clases. Incluso se puede compilar y ejecutar un proyecto desde Enterprise Architect.

Nota: Este producto tiene un coste adicional, por lo que actualmente no se ha considerado su compra.
4.5 MDG for EJB

Permite al usuario modelar EJBs de entidad y de sesion, se completa con perfiles UML para modelar
Ejes, patrones de EJB y gestion de cédigo

Nota: Este producto no tiene coste adicional. Se instala por defecto junto con la herramienta Enterprise
Architect.

El fichero de importacion “EJB Technology.xml” se instala en “C:\Archivos de programa\Sparx
Systems\MDG Link\EJB”

4.6 MDG for Testing

Proporciona la usuario la capacidad de modelar rapidamente un amplio rango de procedimientos de test
incluyendo componentes de testeo, casos de test, y mas

Nota: Este producto no tiene coste adicional. Se instala por defecto junto con la herramienta Enterprise
Architect.

El fichero de importacion “Testing Technology.xml” se instala en “C:\Archivos de programa\Sparx
Systems\MDG Link\Testing”
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